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KI7PRK Cheat Sheet Guide to  Digital Comms
The Narrow Band Emergency Messaging System (NBEMS)

     
Preface
The Narrow Band Emergency Messaging System (NBEMS) is designed as a live operator “1 to 
many” communications system. The programs are all developed by a group of ham 
programmers led by Dave Freese (W1HKJ).  Windows, Mac, Linux and Raspberry Pi are all 
supported.  This document covers the software for using the FLDigi suite of software for 
amateur radio communications. The emphasis is on emergency communications with the core 
suite of programs: FLDigi, FLAmp and FLMsg.  You should learn how to make best use of the 
program by reading the Online Documentation and by practicing off the air. You can also 
access documentation from within the FLDigi program from the Help menu item. The Online 
Documentation has been downloaded from the internet and placed in the FLDigi file structure 
so that it is available even though the computer we are allowed to use at the station does not 
have internet access. 

What is FLDigi? 
FLDigi is the modem computer program used for keyboard to keyboard communications (i.e. 
‘texting’).   FLDigi operates in conjunction with a conventional high frequency single side band 
(HF SSB) radio transceiver, and uses the PC sound card as the main means of input from the 
radio, and output to the radio, i.e. audio-frequency signals. The software also controls the 
radio (e.g. PTT to transmit) by means of a serial port. FLDigi is the program that Whatcom 
County uses to send and receive NBEMS (digital) communications.

 FLDigi is multi-mode, which means that it is able to operate many popular digital modes 
without switching programs, so you only have one program to configure.  FLDigi includes all 
the popular modes, such as DominoEX, MFSK16, PSK31, and RTTY. We will use only digital 
operating modes FSQ 4.5 and MT63-200L.  
 
What is a Digital Mode? 
Digital Modes are a means of operating Amateur radio from the computer keyboard. The 
computer acts as modem (modulator - demodulator), as well as allowing you to type, and see 
what the other person types. It also controls the transmitter, changes modes as required, and 
provides various convenient features such as easy tuning of signals and prearranged 
messages. 

In this context, we are talking about modes used on the HF (high frequency) bands, specifically 
chat modes, those used to have a regular conversation in a similar way to voice or Morse, 
where one operator talks for a minute or two, then another does the same. These chat modes 
allow multiple operators to take part in a net. 

Because of sophisticated digital signal processing which takes place inside the computer, 
digital modes can offer performance that cannot be achieved using voice (and in some cases 
even Morse), through reduced bandwidth, improved signal-to-noise performance and reduced 
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transmitter power requirement. Some modes also offer built-in automatic error correction. 
Digital modes can communicate when voice comms are impossible. Digital Mode operating 
procedure is not unlike Morse operation, and many of the same abbreviations are used. 

Why all the different modes? 
HF propagation is very dependent on the ionosphere, which reflects the signals back to earth. 
There are strong interactions between different signals arriving from different paths. Experience 
has shown that particular modulation systems, speeds and bandwidths suit different operating 
conditions.  Other factors such as available band space, operating speed and convenience, 
noise level, local band plans signal level and available power also affect the choice of mode.  
We will be using FSQ 4.5 for general text messaging and MT63-2000L for sending CERT forms 
(via FLMsg) and photographs (via FLAmp). Make sure the operating mode is the one you need 
to use by checking the FLDigi window at the extreme bottom left.
 
FLDigi settings 
The proper FLDigi settings for KI7PRK are saved in the ‘Quick Guide’ menu of the KI7PRK 
website (http://roadrunner110.wixsite.com/chuckanutacs) and in the “Radio Guides and 
Manuals’ folder on the fire station computer’s desktop.  These settings should not be changed 
without consent from other operators.  If changed, an email should be sent to all members to 
inform them of the change.

Hardware Set Up
The basic equipment requirements include a frequency stable high frequency single side band 
(HF SSB) radio, computer (XP or later, Linux or Mac-OS) and a suitable audio interface from 
radio to computer. KI7PRK uses the Windows operating system and a Tigertronics SignaLink 
interface (other interfaces, including internal computer microphone and speakers, are useable).

Fldigi is a modem program. The primary purpose of Fldigi is to convert ASCII text into tones 
that can then be transmitted using a standard SSB transmitter. At the receiving end, Fldigi 
converts those tones back into readable text.  Just like the old dial up connections we used to 
make to get on the Internet.

The SignaLink USB contains its own sound card and interfaces to the PC with a USB cable. 
Each SignaLink has to be set up for the particular radio you are using. This involves the 
selection of the radio cable and the setting of some internal jumpers. Radio specific 
information is available at http://www.tigertronics.com/sl_wire.htm. SignaLink detailed set up 
instructions are on our web site. Obviously, don’t mess with the SignaLink settings.

http://roadrunner110.wixsite.com/chuckanutacs
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Guided Tour 

FLDigi Window
The main window consists of three main panes. From top to bottom, these are the yellow 
Receive pane (Navajo white), the blue Transmit pane (light cyan), and the black Waterfall pane. 
At the top of these panes is the collection of entry items which form the Log Data, and at the 
very top, a conventional drop-down Menu system, with entries for File, Op Mode, Configure, 
View, Logbook and Help. 

Between the Transmit and the Waterfall panes is a line of boxes (buttons) which represent 
automated tasks (macros). The top buttons match the Function Keys F1 - F12. These are the 
Macro group. Below the Waterfall pane is another line of boxes (buttons), which provide 
various control features. This is the Controls group. The program and various buttons can 
mostly be operated using the mouse or the keyboard, and users generally find it convenient to 
use the mouse while tuning around, and the keyboard and function keys during a QSO. 

Receive Pane 
This is where the text from decoded incoming signals is displayed, in black text. When you 
transmit, the transmitted text is also displayed here, but in red, so the Receive pane becomes 
a complete record of the QSO. The information in this pane can also be logged to a file. 
The line at the bottom of this pane can be dragged up and down with the mouse to decrease 
or increase the viewing area. You might prefer to drag it down a bit to enlarge the Receive pane 
and reduce the size of the Transmit pane.  In addition, you can click on the ‘Mon’ button on the 
right, just above the macro buttons.
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Transmit Pane 
This is where you type what you want to transmit. The mouse must be clicked in here before 
you type (to obtain focus) otherwise your typed text will go nowhere. You can type in here 
while you are receiving, and when you start transmitting, the text already typed will be sent 
first. As the text is transmitted, the text color changes from black to red. At the end of the over, 
all the transmitted text (and any as yet not transmitted) will be deleted. 

Waterfall Pane 
This is the main tuning facility. There are three modes, Waterfall, FFT and Signal, selected by a 
button in the Control group. For now, leave it in Waterfall mode, as this is the easiest to tune 
with, and gives the best identification of the signal. 

 
  
The Waterfall
The waterfall pane is a spectrogram display of signal strength and frequency over passing 
time. The receiver passband is analyzed and displayed with lower frequencies to the left, 
higher to the right. Weak signals and background noise are dark while stronger signals show 
as brighter colors. As time passes (over a few seconds), the historic signals move downwards 
like a waterfall, hence the name. 
 
As you move the mouse around in this pane you will see a yellow group of tuning marks 
following the mouse pointer. Tuning is achieved by left-clicking on a signal displayed by the 
waterfall in this pane. Use these yellow marks to exactly straddle the signal and then left- click 
on the centre of the signal. The tuning marks change to red. The red vertical lines will show the 
approximate width of the active signal area (the expected signal bandwidth), while a red 
horizontal bar above will indicate the receiver software’s active decoding range. When you left-
click, the red marks move to where you clicked, and will attempt to auto-track the signal from 
there. Since we know what frequency our communication will be in, you really don’t need to 
tune via the waterfall.  The waterfall is most useful to indicate that the program is working and 
that you are transmitting or receiving properly.  Keep an eye on the waterfall when the comms 
are good to get a feel for the signal “signature”.

Audio history and “casual tuning” 
You can temporarily “monitor” a different signal by right-clicking on it. As long as you hold the 
mouse button down, the signal under it will be decoded; as soon as you release the mouse, 
decoding will revert to the previously tuned spot (where the red marks are). If you also hold the 
Control key down before right-clicking,  FLDigi will first decode all of its buffered audio at that 
frequency. Rarely would you need to do this.
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Log Data 
 FLDigi provides two QSO entry views, one for casual QSO logging and the second for 
contesting. The View→Contest fields menu item switches between the two modes. 
The Frequency, Time Off, and (when in contest mode) #Out fields are filled by the program. All 
the others can be populated by manual keyboard entry or by selection from the Receive pane. 
The Time Off field is continuously updated with the current GMT time. The Time On field will be 
filled in when the Call is updated, but can be modified later by the operator. 
A right click on the Receive pane brings up a context sensitive menu that will reflect which of 
the two QSO capture views you have open. If you highlight text in the Receive pane then the 
menu selection will operate on that text. If you simply point to a word of text and right click 
then the menu selection will operate on the single word. The program is set to automatically 
log all transmissions and receptions.  Log documents can be found from the menu, 
File→Folders→FLDigi Config.

Quick log entry 
Certain fields (Call, Name, RST In, QTH and Locator) may also be populated semi-
automatically. Point to a word in the Receive pane and either double-left-click or hold a Shift 
key down and left-click. The program will then use some simple heuristics to decide which log 
field will receive the text. 

It is generally not possible to distinguish between Operator and QTH names. For this reason,  
FLDigi will use the first non-Call and non-Locator word to fill the Name field, and subsequent 
clicks will send text to the QTH field. Likewise, a text string may be both a valid callsign and a 
valid IARU (Maidenhead) locator. For best results, you should attempt to fill the log fields in the 
order in which they appear on the main window, and clear the log fields after logging the QSO. 
Of course, text can always be manually typed or pasted into any of the log fields.

You can query online and local (e.g. CD) database systems for data regarding a callsign. You 
make the query by either clicking on the globe button above the yellow Receive pane, or 
selecting Look Up Call from the popup menu. The latter will also move the call to the Call field. 
When the Call field is filled in, the logbook will be searched for the most recent QSO with that 
station and, if an entry is found, the Name, QTH and other fields will be pre-filled. If the 
logbook dialog is open, that last QSO will also be selected for viewing in the logbook. 
You open the logbook by selecting from the View menu; View→Logbook. The logbook title bar 
will show you which logbook you currently have open.  FLDigi can maintain an unlimited 
(except for disk space) number of logbooks. 

Menu 
At the very top of the program window is a conventional drop-down menu. If you click on any 
of the items, a list of optional functions will appear. Keyboard menu selection is also provided. 
Where underscored characters are shown in the menu, you can select these menu items from 
the keyboard using the marked character and Alt at the same time, then moving around with 
the up/down/left/right keys. Press Esc to quit from the menu with no change. 

Menu functions File 
Allows you to open or save Macros, turn on/off logging to file, record/play audio samples, and 
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exit the program. You can also exit the program by clicking on the X in the top right corner of 
the window, in the usual manner. 

Op Mode 
This is where you select the operating modem used for transmission and reception. Some 
modes only have one option. Where more are offered, drag the mouse down the list and 
sideways following the arrow to a secondary list, before releasing it. When you start the 
program next time, it will remember the last mode you used. 
Not all the modes are widely used, so choose a mode which (a) maximizes your chance of a 
QSO, and (b) is appropriate for the band, conditions, bandwidth requirements and permissions 
relevant to your operating license. 
At the bottom of the list are two “modes” which aren’t modes at all, and do not transmit (see 
Online Documentation for details). WWV mode allows you to receive a standard time signal so 
the beeps it transmits can be used for sound card calibration. Freq Analysis provides just a 
waterfall display with a very narrow cursor, and a frequency meter which indicates the received 
frequency in Hz to two decimal places. This is useful for on-air frequency measurement. 
Configure 
  
This is where you set up the program to suit your computer, yourself and your operating 
preferences. The operating settings of the program are grouped into several categories and 
there are menu items in which you enter your personal information, or define your computer 
sound card, for example. Modems can be individually changed, each having different 
adjustments. The Modems dialog has multiple tabs, so you can edit any one of them. Don’t 
fool with the settings until you know what you are doing! The final item, Save Config allows you 
to save the altered configuration for next time you start the program (otherwise changes are 
temporary). 

View 
This menu item allows you to open extra windows. Most will be greyed out, but two that are 
available are the Digiscope, and the PSK Browser. The Digiscope provides a mode-specific 
graphical analysis of the received signal, and can have more than one view (left click in the 
new window to change the view), or maybe none at all. The PSK Browser is a rather cool tool 
that allows you to monitor several PSK31 signals all at the same time! These windows can be 
resized to suit. 

Help 
Brings up the Online Documentation, the  FLDigi Home Page, and various information about 
the program. 

Other controls RSID 
The RxID button turns on the receive RSID (automatic mode detection and tuning) feature. 
When in use, the button turns yellow and no text reception is possible until a signal is 
identified, or the feature is turned off again. If you plan to use the RSID feature on receive, the 
Start New Modem at Sweet Spot item in the menu Configure→Defaults→Misc tab must be 
unchecked. 
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Tune 
This button transmits a continuous tone at the current audio frequency. The tone level will be at 
the maximum signal level for any modem, which makes this function useful for adjusting your 
transceiver’s output power. 

Macro buttons 
This line of buttons provides user-editable QSO features. For example, the first button on the 
left sends CQ for you. Both the function of these buttons (we call them Macros) and the label 
on each button, can be changed. 

Select each button to use it by pressing the corresponding Function Key (F1 - F12, you’ll 
notice the buttons are grouped in patterns four to a group, just as the Function Keys are). You 
can also select them with a left-click of the mouse. If you right-click on the button, you are able 
to edit the button’s label and its function. A handy dialog pops up to allow this to be done. 
There are many standard shortcuts, such as <MYCALL>, which you can use within the 
Macros. Notice that the buttons also turn the transmitter on and off as necessary. 
 
You can just about hold a complete QSO using these buttons from left to right (but please 
don’t!). Notice that at the right are two spare buttons you can set as you wish, and then a 
button labelled 1. Yes, this is the first set of four sets of Macros, and you can access the others 
using this button, which changes to read 2, 3, 4 then 1 again (right-click to go backwards), or 
by pressing Alt and the corresponding number (1-4, not F1-F4) at the same time. 
If you really mess up the Macros and can’t see how to fix them, just close the program without 
saving them, and reopen it. 

Controls 
The line of buttons under the waterfall is used to control the program (as opposed to the QSO). 
If you hover the mouse over these buttons, you’ll see a little yellow hint box appear which tells 
you what each button does. We usually won’t mess with these.

SQL (Squelch) control 
When off (no colored indicator on the button), the receiver displays all “text” received, even if 
there is no signal present, and the receiver is simply attempting to decode noise. When 
activated by pressing the button, the indicator turns yellow. If the incoming signal strength 
exceeds that set by the adjacent slider control (above the SQL button), the indicator turns 
green and the incoming signal is decoded and printed. The signal strength is indicated on the 
green bar beside the Squelch level slider. If nothing seems to be printing, the first thing to do is 
check the Squelch! 

Status Line 
At the very bottom line of the  FLDigi window is a row of useful information. At the left is the 
current operating mode. Next (some modes) is the measured signal-to-noise ratio at the 
receiver, and (in some modes) the measured signal intermodulation level (IMD). 
The larger central box shows (in DominoEX and THOR modes) the received Secondary Text. 
This is information (such as station identification) which is transmitted automatically whenever 
the transmitter has completed all user text that is available to send. It is transmitted using 
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special characters, and is automatically directed to this special window. Secondary text you 
transmit is also shown here. This box changes size when you enlarge the program window. 

Operating Procedure 
Operating procedure for digital modes is similar to that for Morse. Some of the same 
abbreviations are used. For example, at the beginning of an over, you might send VK3XYZ de 
WB8ABC or just RR Jack and so on. At the end of an over, it is usual to send ZL1ABC de 
AA3AR K, and at the end of a QSO 73 F3XYZ de 3D2ZZ SK. When operating in a group or net 
it is usual to sign AA3AE es gp de ZK8WW K. 

It is also considered a courtesy to send a blank line or two (press Enter) before any text at the 
start of an over, and following the last text at the end of an over. You can also place these in 
the macros. The purpose is to separate your text from the previous text, and especially from 
any rubbish that was printed between overs. 

 FLDigi does all of this for you. The Function Keys are set up to provide these start and end of 
over facilities, and can be edited to suit your preferences. In order that the other station’s 
callsign can appear when these keys are used, you need to set the other station’s callsign in 
the log data — it does not matter if you use the log facility or not. 

Macro symbols 
Some Function Key Macro buttons have graphic symbols on them which imply the following: 
>> The transmitter comes on and stays on when you use this button/macro. 
|| The transmitter goes off when the text from this button/macro has been sent. 
>| The transmitter comes on, sends the text from this button/macro, and goes off when the 
text from this button/macro has been sent. 

The Macros are set up to control the transmitter as necessary, but you can also switch the 
transmitter on at the start of an over by pressing the Ctrl and T keys simultaneously or the TX 
macro button, and off again by pressing the Ctrl and R keys simultaneously or the RX macro 
button. If you have Macros copied into or text already typed into the Transmit pane when you 
start the transmitter, this is sent first.  Calling another station you have tuned in is as simple as 
pushing a button. Put his callsign into the log data (right click, select Call) and press the ANS 
Macro button (or F2) when you are ready. If he replies, you are in business! Then press QSO 
(F3) to start each over, and BTU (F4) to end it, and SK (F5) to sign off. 

When typing text, the correct use of upper and lower case is important: 
Modes such as RTTY and THROB have no lower case capability. 
In most other modes, excessive use of upper case is considered impolite, like SHOUTING! 
Modes such as PSK31, MFSK16, DominoEX and THOR use character sets which are 
optimized for lower case. You should use lower case as much as possible in these modes to 
achieve maximum text speed. In these modes upper case characters are noticeably slower to 
send and also slightly more prone to errors. 

Special Keys 
Several special keyboard controls are provided to make operating easier. 
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Start Transmission 
Press the Ctrl and T keys simultaneously to start transmission if there is text ready in the 
transmit buffer. 

Pause Transmission 
Press Pause or Break while in receive, and the program will switch to transmit mode. It will 
continue with the text in the transmit buffer (the Transmit pane text) from the current point, i.e. 
where the red (previously sent) text ends and the black (yet to be sent) text begins. If the buffer 
only contains unsent text, then it will begin at the first character in the buffer. If the buffer is 
empty, the program will switch to transmit mode, and depending on the mode of operation, will 
send idle characters or nothing at all until characters are entered into the buffer. 
If you press Pause or Break while in transmit mode, the program will return to receive mode. 
There may be a slight delay for some modes like MFSK, PSK and others, that requires the 
transmitter to send a post amble at the end of a transmission. The transmit text buffer stays 
intact, ready for the Pause/Break key to return you to the transmit mode . 
Pressing Alt or Meta and R has the same effect as Pause/Break. You could think of the Pause/
Break key as a software break-in capability. 

Escape 
Pressing Esc while transmitting will abort the transmission. Transmission stops as soon as 
possible, (any necessary post amble is sent), and the program returns to receive. Any unsent 
text in the transmit buffer will be lost.  
 
If you press Esc Esc (i.e. twice in quick succession), transmission stops immediately, without 
sending any post amble, and the program returns to receive. Any unsent text in the transmit 
buffer will be lost. Use this as an emergency stop. 

Return to Receive 
Pressing the Ctrl and R keys simultaneously to insert the ^r command in the transmit buffer at 
the current typing point. When transmission reaches this point, transmission will stop. 

Move Typing Cursor 
Press Tab to move the cursor (typing insertion point) to the end of the transmit buffer. This will 
also pause transmission. A Tab press at that position moves the cursor back to the character 
following the last one transmitted. Morse operation is slightly different. (See the Online 
Documentation for CW).  You can also click at the desired insertion point with the mouse.

Send Any ASCII Character 
Press Ctrl and (at the same time) any three-digit number (on the numeric keypad or the normal 
numeric keys) to insert the ASCII character designated by that entry value into the transmit 
buffer. For example, Ctrl 177 is “±” (plus/minus) and Ctrl 176 is “°” (degree). If you press a key 
other than the numeric keypad’s 0-9 the sequence will be discarded. 

Credits 
Beginners' Guide to Fldigi - License GPLv2+: GNU GPL version 2 or later.

http://www.gnu.org/licenses/gpl-2.0.html
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KB1TCE Rev 24 Sept 2012

1. Secondary text is transmitted when the text you type does not keep up with the typing speed of the mode — 
this handy text appears in a small window at the very bottom of the screen. 
Last updated 2017-02-28 15:08:37 

Addendum: Audio Coupling 
Instead of using an electronic interface such as the SignaLink, you can also use your radio and 
computer’s microphones and speakers to transfer the audio information. This works well with 
the MT63 modes on VHF/UHF FM but is far less reliable with HF modes. Setting levels is more 
trial and error than when using a dedicated interface but this capability can be important when 
in the field and provides a good way to get started without any extra expenditures. 

- Turn off your Windows sounds. You don’t want Bill Gates’ bleeps and burbles to 
go out over the air. Go to Control Panel – Sounds and Audio Devices – Sounds and select “No 
Sounds.” 

- While you are in there set your mic and speaker audio levels to “typical” 
positions. You don’t want the MT63 tones screeching at you. Have the PC speaker adjusted to 
about the volume that your normally speak when transmitting. When you hold the radio’s mic 
about the same distance from your speaker as you have your mouth then you should be ok. 
For receiving, if your radio’s speaker is some distance (a few ft) from the computer’s mic, turn 
off your squelch and turn up your computer’s record level to the point where you see the noise 
clearly on Fldigi’s waterfall. You don’t want to overdrive. Copy will be much better at low audio 
levels. You will have to experiment to find the correct settings for consistent copy and 
transmission. 

Derived from KB1TCE Rev 24 Sept 2012 

       


